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MIPAR

Getting Started

MIPAR User Manual - v4.5_en

Welcome to the MIPAR User Manual!

This manual is meant to complement the various tutorials and 1-on-1 training sessions available on the
MIPAR website. It offers an overview of the each application, and provides a comprehensive description of

the Image Processor’s function library.
Topics

This Section

+ Install and Activate

* Introduction

» Supported Formats

+ System Requirements
*+ GPU Computation

» Tutorials

» Recipe Store

Other Sections

* Image Processor

+ Batch Processor

+ Real-Time Processor

» Session Processor / Al Session Processor
+ 3D Toolbox

* Report Generator

» Spotlight

* Live

» Checkpoint: Compliance by TotallLab
+ Python API

+ REST API

* Release Notes

» [nstall and Activate

* Introduction

» Supported Formats

+ System Requirements
+ GPU Computation

» Preferences

+ Keyboard Shortcuts
» Tutorials

* Recipe Store
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MIPAR MIPAR User Manual - v4.5_en

Install and Activate

Documents

+ Installation + Trial Activation — WINDOWS
Describes procedures for installing, activating, and setting up MIPAR on Windows systems

+ Installation + Trial Activation — MAC
Describes procedures for installing, activating, and setting up MIPAR on Mac systems

* Local License Activation
Describes procedures for retrieving and activating your purchased local License Key

* Network License Activation — SERVER
Describes procedures for retrieving and activating your purchased network License Key, and for
configuring your license server

» Network License Activation — VM SERVER
Describes procedures for retrieving and activating your purchased network License Key, and for

configuring your license server

* Network License Activation — CLIENT
Describes procedure for configuring client systems on your network to use network seats

» Network License Manager README
Detailed documentation on installing and configuring your license server, including supported

operating systems.

Troubleshooting

« |nstallation Troubleshooting

» Activation Troubleshooting

» License Key Transfer

Page 13 of 670


https://mipar-installer.s3.amazonaws.com/MIPAR_Installation-Instructions_Win.pdf
https://mipar-installer.s3.amazonaws.com/MIPAR_Installation-Instructions_Mac.pdf
https://mipar-installer.s3.amazonaws.com/MIPAR_Local-Activation_Instructions.pdf
https://mipar-installer.s3.amazonaws.com/MIPAR_Network-Activation_Instructions_SERVER.pdf
https://mipar-installer.s3.amazonaws.com/MIPAR_Network-Activation_Instructions_VM_SERVER.pdf
https://mipar-installer.s3.amazonaws.com/MIPAR_Network-Activation_Instructions_CLIENT.pdf
https://docs.sentinel.thalesgroup.com/ldk/LDKdocs/rte/win-cmd/Windows/Overview-Win.html

MIPAR

Installation Troubleshooting

MIPAR User Manual - v4.5_en

Error

MIPAR crashes on starup or during
launching of an app

OR

HASP API DLL dynamically unloaded
with active logins

Message on Mac stating that “MIPAR
Installer cannot be opened because it
is from an unidentified developer”.

Permissions setting error during
installation stating that “Icacls’ is not
recognized as an internal command,
operable program or batch file.”

On startup error: Failed to set up java
output streams

Cause

MIPAR crashed on startup and thus

did not properly log out of the
license. This is a symptom rather
than the cause of the crash.

macOS is not recognizing MIPAR

Software as an identified developer

Incorrect PATH variable

Runtime environment was not
installed properly

Possible Solution

Windows: Try updating your
graphics card driver (see below
links). If the problem persists, try
the solution below.

NVIDIA: https://www.nvidia.com/
download/index.aspx?lang=en-

us

AMD: https://www.amd.com/en/

support

Intel:
https://downloadcenter.intel.com/
product/80939/Graphics

- Right-click on MIPAR Installer
- Click “Open”

- Click “Open” in the message
that appears

- Open System Properties >
Advanced tab > Environment
Variables > System variables

- Make sure the Path variable
contains the entries
“C:\Windows\system32” and
%SystemRoot%\system32

- Retry running MIPAR Installer

- Uninstall MRE (MATLAB
Runtime 9.11)

- Download and run installer
from Link

- Restart the system and MIPAR
- Additional Steps

- Check for other Runtime paths
in the ‘Path’ Environment
Variable

- Move v911 path higher by
selecting Move Up

- Save and Restart System

Page 14 of 670


https://www.nvidia.com/download/index.aspx?lang=en-us
https://www.nvidia.com/download/index.aspx?lang=en-us
https://www.nvidia.com/download/index.aspx?lang=en-us
https://www.amd.com/en/support
https://www.amd.com/en/support
https://downloadcenter.intel.com/product/80939/Graphics
https://downloadcenter.intel.com/product/80939/Graphics
https://ssd.mathworks.com/supportfiles/downloads/R2021b/Release/4/deployment_files/installer/complete/win64/MATLAB_Runtime_R2021b_Update_4_win64.zip

MIPAR

On startup error: Could not access the Permission issue accessing runtime
MATLAB runtime component cache.

Interface buttons and text display
incoherent text

MIPAR takes an extremely long time
to launch on a system with an NVIDIA  MIPAR must recompile CUDA
drivers on launch

Ampere architecture video card
installed

environment

Fonts were not installed properly

MIPAR User Manual - v4.5_en

- Launch MIPAR as
administrator by right-clicking >
Run as administrator

If problem persists:

- Uninstall MRE (MATLAB
Runtime 9.11)

- Download and run installer
from Link

- Restart the system and MIPAR

- Close MIPAR

- Navigate to C:\ProgramFiles\
MIPAR\fonts

- Select all .ttf and .off files

- Right click > Install (or “Install
for all users” if available)

- Launch MIPAR

Add Environmental variable:
CUDA _CACHE_MAXSIZE with
a variable value: 536870912

Solution for Crash on Startup or “HASP API DLL dynamically

unloaded” Message (Windows)

This error occurs when the MIPAR Runtime crashes on boot. Please try in order:

Delete the MCR Cache

* Navigate to the MIPAR install folder, default: C:\Program Files\MIPAR\

* Delete the folder: mcrCache9.11

* Restart Computer
 If this does not work, try:

Delete Preferences

* Navigate to C:\Program Files\MIPAR (installation path)
» Delete miparPreferences.pref

* Retry MIPAR launch
 If this does not work, try:

Reinstall the Runtime
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* Uninstall the runtime from the system: MATLAB Runtime 9.11
 Download and install the runtime: LINK

* Restart the computer

 If this does not work, try:

Adjust Permissions

* Try launching MIPAR as an admin
« Are you running an antivirus program? Does whitelisting MIPAR resolve the problem?

Page 16 of 670


https://ssd.mathworks.com/supportfiles/downloads/R2021b/Release/3/deployment_files/installer/complete/win64/MATLAB_Runtime_R2021b_Update_3_win64.zip

MIPAR

Activation Troubleshooting

MIPAR User Manual - v4.5_en

Error During

MIPAR crashes on starup or during
launching of an app

OR

HASP API DLL dynamically
unloaded with active logins

Startup

License Manager not reachable
OR
Unknown Error

Activation

Cause

MIPAR
crashed on
startup and
thus did not
properly log
out of the
license. This
is a symptom
rather than
the cause of
the crash.

License
Manager
may not
have been
installed
properly OR
License
Manager
may be out-
of-date

Possible Solution

Try updating your graphics card driver (see
below links). If the problem persists, try
launching MIPAR as Administrator. If the
problem still remains, try uninstalling and
reinstalling MIPAR

NVIDIA: https://www.nvidia.com/download/
index.aspx?lang=en-us

AMD: https://www.amd.com/en/support

Intel: https://downloadcenter.intel.com/product/
80939/Graphics

Try accessing
http://localhost:1947/_int /ACC_help_index.html.

If this page cannot be reached:
- See Solution for License Manager Not
Reachable below.

If this page can be reached:

WINDOWS

- Update to the latest License Manager version
for Windows

- If this still does not resolve the issue, try
activating the license manually: Quit MIPAR >
Go to http://localhost: 1947/ int_/checkin.html >
Click “Choose File” > choose .v2c license key
file > Click “Apply File” > Launch MIPAR

MACOS

- Update to the latest License Manager version
for Mac

-If this still does not resolve the issue, try
activating the license manually: Quit MIPAR >
Go to http://localhost: 1947/ int_/checkin.html >
Click “Choose File” > choose .v2c license key
file > Click “Apply File” > Launch MIPAR
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MIPAR

Message on Mac stating that “MIPAR

cannot be checked for malicious Activation

software”.

Cannot select .v2c file on Mac Activation

Spinning wheel after selecting a o
Activation

license type on Mac

HASP_UPDATE_ALREADY_ADDED Activation

HASP_DEVICE_ERR Activation

HASP_CLONE_DETECTED

Activation
OR

macOS is
not
recognizing
MIPAR
Software as
an identified
developer

.v2c file was
saved with a
xml
extension
and cannot
be selected
after clicking
“Activate”

Third-party
software may
be interfering
with MIPAR

This MIPAR
License has
already been
activated
previously.

An issue
which affects
some Mac
systems
running
macOS
10.13 High
Sierra, or on
Windows
systems
could be
caused by
corrupted
secure
storage.

A change in
your
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— Right-click on MIPAR
- Click “Open”
- Click “Open” in the message that appears

First remove the .xml extension and retry
activation. If this does not work, open the file in
Text Edit and resave it with only the .v2c
extension. When saving, make sure to uncheck
the box which says “Add .txt if no extension is
present”

Apps such as BetterTouchTool, Magnet, or
Grammarly can affect MIPAR performance on
Mac. If you use these apps, disable them while
using MIPAR.

If you have not requested a trial license, you
may do so here. Visit our Purchase Page to
obtain a quote for local or network licenses.

See Solution for HASP _DEVICE ERR below

See Solution for HASP_CLONE _DETECTED
below
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MIPAR

“Cloned” / “Secure Storage ID
Mismatch” shown next to some keys

HASP_NO_VLIB

HASP_HASP_NOT_FOUND

HASP_FEATURE_NOT_FOUND

HASP_FEATURE_EXPIRED

Activation

Activation

Activation

Activation

MIPAR User Manual - v4.5_en

system’s
hardware
has caused
the license to
be
temporarily
deactivated
for clone
protection
reasons.

The vendor
library
required to
activate
MIPAR
licenses was

See Solution for HASP_NO VLIB below

not properly
copied over
during the
installation.

A MIPAR

License has

not been

activated, or  Please be sure to follow the instructions in the
cannot be Activation Window (which appears after MIPAR
found on is launched) to activate your license.

your network

(for network

licenses).

A MIPAR

License has

not been

activated, or  Please be sure to follow the instructions in the
cannot be Activation Window (which appears after MIPAR
found on is launched) to activate your license.

your network

(for network

licenses).

Your MIPAR  If you have not requested a trial license, you
License has  may do so here. Visit our Purchase Page to
expired. obtain a quote for local or network licenses.
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Your .v2c file

may have
L been Please contact support@mipar.us for
HASP INV_UPDATE_DATA Activation .
- - - corrupted assistance.
during
download.
The
concurrent .
o You'll need to wait for another user to close
user limit on MIPAR. Contact H@mi o .
. Contact support@mipar.us to inquire
HASP_TOO_MANY_USERS Activation your network o r?r-) 0 g
i about obtaining additional seats for your network
license has )
license.
been
reached.
Sentinel . . .
license Try Local Offline Activation, otherwise add a
i
i ) i firewall rule to allow connection for the Sentinel
Java Exception Occurred: Sentinel manager is ) , .
] ) B o license managed (this can be disabled after
EMS is not available for the specified Activation not able to o ]
) activation) Instructions: LINK HASP executable:
URL communicate ) . )
C:\Program Files (x86)\Common Files\Aladdin
through the
) Shared\HASP\hasplms.exe
firewall.

Solution for License Manager Not Reachable

Windows

Check License Manager Service

1. In the Windows search bar type Services

2. Open the Services app

3. Scroll down to Sentinel LDK License Manager

4. If it exists and is stopped, select it and click Start in the left panel to start the service
5. If it does not exist, proceed with steps 6-15

Set Environment Variables

6. Open Command Prompt as Administrator and execute the following commands:
7. MKDIR c:\Idktemp

8. SET TEMP=C:\Idktemp

9. SET TMP=C:\Idktemp

Repair License Manager

10. Download the License Manager package for Windows
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11. Extract the downloaded Install_License_Manager_Win.zip (Right-click > Extract All)
12. Inside the extracted folder, double-click Install License Manager.bat
13. Retry activation through MIPAR’s Activation Window

Mac

Repair License Manager

1. Download the License Manager package for Mac
2. Double-click the downloaded Install_License_Manager_Mac.pkg
3. Follow the prompts to complete the License Manager update

Add Vendor Library

4. Download the MIPAR Vendor Library for Mac
5. From menu bar in Finder, select Go > Go to folder > type /var/hasplm and press Enter
6. Place the downloaded haspvlib_111047. dylib file here

Allow Vendor Library

7. Right-click on the haspvlib_111047. dylib file > Open

8. If you see a message which states that “haspvlib_111047 is from an unidentified developer...”, choose
Open

9. Quit Terminal if it opens

10. If there was no “Open” button in the previous message, go to System Preferences > Security & Privacy
> General > click Allow next to the message toward the bottom

Restart License Manager

Restart License Manager

11. In Spotlight search bar type Terminal

12. Open Terminal app

13. Type sudo launchctl unload /Library/LaunchDaemons/com.aladdin.hasplmd.plist and press Enter
14. Type sudo launchctl load /Library/LaunchDaemons/com.aladdin.hasplmd.plist and press Enter

Solution for HASP_DEVICE_ERR

Windows

Repair License Manager

1. Download the License Manager package for Windows
2. Extract the downloaded Install_License_Manager_Win.zip (Right-click > Extract All)
3. Inside the extracted folder, double-click Install License Manager.bat
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Mac

Repair License Manager

1. Download the License Manager package for Mac

2. Double-click the downloaded Install_License_Manager_Mac.pkg

3. Follow the prompts to complete the License Manager update

4. After the installer finishes, and the green check mark is shown, leave the installer window open and
proceed with steps 5-6

Allow in System Preferences

5. Go to System Preferences > Security & Privacy
6. Click the “Allow” button next to “SFNT Germany GmbH” (close the installer window and try clicking
“Allow” again if it does not respond at first)

Solution for HASP_CLONE_DETECTED

Check for Cloned Key

1. On your MIPAR system, go to http://localhost: 1947/ int_/devices.html

2. If there is a key marked with a red “Cloned” or “Secure Storage ID Mismatch”, click the “C2V” button in its
“Actions” column, and send the C2V file to support@mipar.us. If there are no visible keys, proceed with
steps 3-5. If there are visible keys, skip to step 6.

Repair License Manager

For Windows

3. Download the License Manager package for Windows
4. Extract the downloaded update_license_manager_win.zip (Right-click > Extract All)
5. Inside the extracted folder, double-click Update License Manager.bat

For Mac

3. Download the License Manager package for Mac

4. Double-click the downloaded Install_License_Manager_Mac.pkg > Follow the prompts to complete the
License Manager update

5. Go to http://localhost: 1947/ int_/devices.html and see if any keys show up

Download and Send C2V

6. Locate the key marked with red “Cloned”, click the “C2V” button under its “Actions” column, and send the
C2V file to support@mipar.us. If there are still no visible keys marked “Cloned”, please contact
support@mipar.us for further assistance.
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Solution for HASP_NO_VLIB

Windows

Add Vendor Library

1. Download the MIPAR Vendor Library for Windows
2. In Windows Explorer, navigate to C:\Program Files (x86)\Common Files\Aladdin Shared\HASP
3. Place the downloaded haspvlib_111047.dll file here

Restart License Manager

4. In the Windows search bar type Services

5. Open the Services app

6. Scroll down to Sentinel LDK License Manager
7. Select it and click Restart in the left panel

Mac

Add Vendor Library

1. Download the MIPAR Vendor Library for Mac
2. From the menu bar in Finder, select Go > Go to folder > type /var/hasplm and press Enter
3. Place the downloaded haspvlib_111047. dylib file here

Allow Vendor Library

4. Right-click on the haspvlib_111047. dylib file > Open

5. If you see a message which states that “haspvlib_111047 is from an unidentified developer...”, choose
Open

6. Quit Terminal if it opens

7. If there was no “Open” button in the previous message, go to System Preferences > Security & Privacy >
General > click Allow next to the message toward the bottom

Restart License Manager

Restart License Manager

8. In Spotlight search bar type Terminal

9. Open Terminal app

10. Type sudo launchctl unload /Library/LaunchDaemons/com.aladdin.hasplmd.plist and press Enter
11. Type sudo launchctl load /Library/LaunchDaemons/com.aladdin.hasplmd.plist and press Enter
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License Key Transfer

Please contact support@mipar.us with your request to transfer a license. A representative will be in contact
shortly after to assist you.

* License transfers are only available to users with an active Maintenance Plan, and are
limited to 3 per year.

Page 24 of 670


mailto:support@mipar.us

Introduction

MIPAR is a revolutionary image analysis software, capable of identifying and measuring features from

nearly any image one can capture. Our users have shown it to be perhaps the most the efficient and flexible

image processing software on the planet.
Through five integrated applications, MIPAR offers powerful and efficient environments for the different

tasks performed during 2D and 3D image analysis. Developed by materials scientists, it is uniquely
designed to offer workflows that are well-suited to solve a variety of scientific image analysis problems.

Launching MIPAR

D MIPAR | v20.0 -

Launch Bar Requires 3D Extension
Allows launching of any application

Status Bar

Displays progress bars, messages,
and helpful instructions

The Apps

« |mage Processor

The most commonly used app. Used for building and editing Recipes, as well as applying Recipes to
single images. Recipes are sequences of image processing steps which work to identify features of

interest from your image.

- Batch Processor

Used for batch applying a Recipe to multiple images. A batch process will save the last Recipe step

(or each Layer) for each image, along with a spreadsheet of global measurements, if there were
measurements in the Recipe.
With 3D Extension: The Batch Processor can output Image Stacks and 3D Reconstructions



MIPAR MIPAR User Manual - v4.5_en

« Real-Time Processor

Similar to the Batch Processor, but used for applying a Recipe to multiple images, every time a new
image is added to a folder being “watched”. This is typically a folder on a network storage drive, such
that images may be processed in real-time as they acquired and saved from an imaging instrument.
With 3D Extension: The Real-Time Processor can output Image Stacks and 3D Reconstructions

» Session Processor/Al Session Processor

Used for reviewing the results of a batch or real-time process. All saved processed images are loaded
and overlaid/outlined, etc. on their respective references. The user can flip through each processed
result to assess accuracy. Manual edits can be made to correct errors. Global and feature
measurements can be made from all processed images at once. With the Deep Learning Extension
on your license, the app is named Al Session Processor, and can train new Deep Learning Models.

» 3D Toolbox (requires 3D Extension)
Used for visualizing and editing Image Stacks, as well as visualizing, editing, and quantifying 3D
Reconstructions. Reconstructions can be exported to other visualization applications such as
commercial Avizo open source ParaView and for high-end rendering and animation.
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Supported Formats

2D Formats

The following 2D image formats are supported for use in the Image Processor, Batch Processor, Real-Time
Processor, and Session Processor:

« TIF

+ JPG

« BMP

* PNG

* GIF

» Bio-Formats (over 150 formats )

Requires downloading the Bio-Formats package and placing inside the “plugins” folder in your
installation directory

* As of v4.0.0.0, MIPAR now prompts users to download a newer version of the Bio-Formats
library which patches the log4j vulnerability, when opening speciality formats for the first
time. Users currently running the older version will be prompted to update on launch. We
strongly recommend updating. To update manually, download the new library version, place
the .jar file in [Install Directory]/plugins and restart MIPAR.

* MIPAR scales images to 8-bit on load. MIPAR by default will auto contrast higher bit
images, to turn off auto contrast on load (File>Preferences>Normalize Image Before
Scaling)

3D Formats

MIPAR creates 3D Reconstruction files from a series of 2D images through use of the Batch Processor or
Real-Time Processor. 3D Reconstruction files are saved from the Batch Processor or Real-Time Processor
in MIPAR’s REC format and can be opened in the 3D Toolbox.
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System Requirements

Supported Operating Systems

Windows (64-bit only)

* Windows 11

* Windows 10

* Windows 7 SP 1

* Windows Server 2019
* Windows Server 2016

Note: There is a known problem with Windows 7 SP1 build 7601 ran on Intel® Core™
i9-7900X CPU in MIPAR version 3.x.x that might cause the software to crash.

o =

Mac

*+ macOS Ventura (13.0)

* macOS Monterey (12.0)

* macOS Big Sur (11.0)

*+ macOS Catalina (10.15.7 or later)

Note: Apps such as BetterTouchTool, Magnet, or Grammarly can affect MIPAR
performance on Mac. If you use these apps, we recommend disabling them while using
MIPAR.

o =

Note: MIPAR is not yet optimized for Apple Silicon Macs, but will run under Rosetta 2. Full
Apple Silicon support is planned for a future release.

=

Supported Languages

MIPAR’s user-interface is only available in English, but it can be installed on all languages of Windows and

macOS.

Minimum System Requirements

» CPU: Dual-core modern Intel / AMD
* GPU: Intel HD 4000 level graphics
+ Storage: HDD 5400 RPM
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* RAM: 4 GB

Recommended System Specs

» CPU: 8+ core modern Intel / AMD

+ GPU: NVIDIA GeForce GTX 1060 or better
» Storage: SSD (Solid State Drive)

+ RAM: 16+ GB

Deep Learning Requirements

Spotlight Requirements
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GPU Computation

Enable

From any app, launch File > Preferences. In the GPU panel, set to “GPU Computation” to “On” if you have a
supported GPU. Click here to learn more about the technical aspects and benefits of GPU computation.

* GPU computation requires an NVIDIA GPU with compute capability 3.5 to 8.x (Kepler,
Maxwell, Pascal, Volta, Turing, or Ampere architecture), and your driver must support
CUDA Toolkit 11 or higher. We recommend you update your NVIDIA driver to the latest
version here. Learn more about CUDA here.

«¥s For GPU requirements for deep learning training, see Deep Learning System Requirements.

Some functions may produce slightly different results when run on the GPU vs. the CPU.

=

Supported Functions

The following functions support GPU Computation:

Edit

+ Crop Image
* Resize Image
» Rotate Image

+ Flip Image
« Translate Image

* *Reqister Image: Free-Form, Translation, Rigid, Affine
« Sparsely Sample Image
« Draw Random Lines

Color

* Color Cluster
e Color Deconvolution
« Channel Operation

Pre-Processing

* Adjust Contrast
» Flatten Background
+ Smart Cluster
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* Wiener Filter

+ Gaussian Blur

+ Average Blur

+ Sum Filter

» Grayscale Dilate

» Grayscale Erode

+ StdDev Filter

+ Gradient Filter

+ Highlight Lines

» Bright Texture

» Dark Texture

» Advanced Texture

» Pattern Mapping

» Orthogonal Correlate
* *Cross-Correlate

+ Sharpen

» FEFT Filter

+ Make FFT

* Apply Stored FFT Filter
* *Grayscale Interpolation

Segmentation

* Invert

* Blank

» Basic Threshold

+ Range Threshold

» Adaptive Threshold
*+ E-M Threshold

* *Local Threshold

» Find Edges

+ Find Circles

* Find Lines

» Find Text

+ Find Facial Features
* *Region Grow

* Find Global Maximum
+ Find Global Minimum
» Find Local Maxima

+ Find Local Minima

Deep Learning

* Apply Model
+ Call Output
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Morphology

Uniform Dilation
Smart Dilation
Retain Dilation
Uniform Erosion
Smart Erosion
Retain Erosion
Smooth Features
Extend Features

Perimeter Pixels
Skeletonization
Thin

Shrink

Distance Map

Clean-Up

Relative Size Filter

MIPAR User Manual - v4.5_en

+ Replace With: Centroid, Ellipse, Equivalent Circle, Fit Circle, Largest Circle, Local Normal, Major Axis,

Minor Axis, Nearest Distance, Triangulation
Mark Center

Memory

Set Companion Image
Load Companion Image
Call Companion Image
Set Memory Image #1-6
Call Memory Image #1-6
Call Original Image

*Feature Union

*Feature Minus

*Feature Intersection
*Keep Exclusive Features
Make Grayscale

*Add

*

Average

*Divide

*Multiply

*Subtract

Add Value

*Merge Darker Pixels
*Merge Lighter Pixels
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Preferences
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Layout
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1. MIPAR Open Directory

MIPAR Preferences

STARTUP DIRECTORY
| /Appiications/MIPAR

' Link Export Folder to Image Folder

2. Calibration and Measurement Units WI:-8 3 Feature Numbering Order

Units 2D Labeling Order

M t Calborat
easuremen ation Left-to- ) 2

m 4. Corner Pixel Connectivity

Theme Default Preview e Ry

—
- v

+/ Double-Click Step to Edit
Default 3D Auto Re-label
v Default Zoom On in Preview

PROMPTS
5. Memory Allocation for

V' Check for Updates on Startup Proprietary File Formats
Specialty Format Memory

ki N [a0%6 |me

~/ Show Startup Guide

. Show Recipe Templates

3D Renderer

IMAGE 6. Image Scaling OpenGL o)

Scale to 8-bit on Load

v/ Nommalize Image Before Scaling

TIF Compression on Save

Non-binary Binary Obiecti
csn Ot

7. Image Scaling
ACCELERATION 8. GPU and Hardware Acceleration

GPU Computation Hardware Acceleration Parallel CPU Grid

'
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1. MIPAR Open Directory

Default folder for opening and image or recipe on MIPAR launch.

2. Calibration and Measurements Units

Calibration units are used to display the scale bar and are used as default during recipe calibration.
Measurement units are used for measurement unit generation.

3. Feature Numbering Order

MIPAR numbers features during Reject Features function and during feature measurement generation. Left
to right numbering will number features from the left edge of the image to the right. Top to Bottom
numbering will number features from the top edge of the image to the bottom.

4. Corner Pixel Connectivity

Distinct features can be identified using two different methods. 4-pixel connectivity and 8-pixel connectivity.

-1 | -1 | -1 0 | -1 0

-1 -1 -1 -1

- ey [ | 0O | -1 | 0

(a) (b)

Image Source

5. Memory Allocation for Proprietary File Formats

MIPAR is able to open proprietary file types which are handled using a dedicated library. If MIPAR throws
out of memory errors when the workstation is not out of memory, adjust this setting to allocate more memory


https://www.researchgate.net/figure/a-8-pixel-connectivity-b-4-pixel-connectivity_fig5_324229653
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to MIPAR.

6. Image Scaling

MIPAR scales all opened images to 8-bit, scaling can be done by normalizing the images to the min and
max values. We recommend disabling this setting for projects that requires intensity measurements.

7. TIFF Compression
Set compression preference for binary and non-binary (greyscale, color) images.

Non-binary: Izw(default), packbits, none, |zw, deflate.
Binary: ccitt(default), packbits, none, Izw, deflate, fax3, fax4.

8. GPU and Hardware Acceleration
GPU Computation is recommended for large images to accelerate image processing. Note that GPU
selection for applying Deep Learning models is a separate setting that overrides this preference in the Apply

DL Model function.

Hardware Acceleration is supported on some CPUs to improve MIPAR interface and measurement
performance.

! Note: Some measurements can be impacted by this setting, to ensure consistent results
across multiple systems make sure this setting is consistent.

Parallel CPU Grid is used for some functions to accelerate processing. This value defaults to half the
number of physical cores on the system.
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Keyboard Shortcuts

o¥s On Mac systems, use CMD instead of CTRL.

All Windows
Zoom CTRL+D or Scroll Wheel
Pan CTRL+F or Scroll Click and Drag

Toggle Zoom/Pan CTRL

Measure (if appl.) CTRL+M

Recipe Step Preview Windows

Toggle Preview SHIFT
Cycle Ul Elements TAB / SHIFT+TAB

Navigate Radio Buttons UP / DOWN ARROWS

Accept Text Entry ENTER
Accept Window SHIFT+ENTER
Cancel Window ESC

Windows with Manual Editing Tools

Switch Editing Tools NUMBER KEYS (1, 2, 3...)

Fill Mode CTRL+A
Erase Mode CTRL+S
Undo CTRL+Z

Image Processor

Open Image CTRL+O
Load Recipe CTRL+L
Save Reference Image CTRL+1

Save Current Image CTRL+2
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Save All Layers CTRL+3
Save Recipe CTRL+R
Undo CTRL+Z

Session Processor

Load Session CTRL+L

Save Session CTRL+R

Save Current Image CTRL+2

Save All Images CTRL+3
Manual Editing See above table
Change Current Image LEFT/RIGHT

Change Active Layer  UP/DOWN

3D Toolbox
Open Image Stack CTRL+I
Open Reconstruction CTRL+O
Save Stack CTRL+T
Save Recon CTRL+S

Undo Last Stack Change CTRL+X
Undo Last Recon Change CTRL+Z

Rotate 3D CTRL+G
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Tutorials

Watch video tutorials on how to use many of MIPAR'’s features:

* Overview
* Image Processor
- Batch Processor

» Session Processor
« Al Session Processor
« 3D Toolbox
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Overview

Tour

Take a tour of MIPAR’s powerful features and intuitive workflow. You’ll see examples of feature detection,
batch processing, and measurements.

MIPAR

Image Analysis Soffware

Demo

Watch a full demo of MIPAR’s operation including the Image Processor, Batch Processor, and Post
Processor apps.


https://www.youtube.com/embed/ws-AQkPSgOw?rel=0



https://www.youtube.com/embed/D9vF77EB4hY?rel=0
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Image Processor

Detecting

Creating a Recipe

Describes the process of creating a segmentation recipe to identify features of interest in an image.
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Optimizing Steps

Shows the procedures and applications for optimizing, or objectively determining, image processing
parameters.
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https://www.youtube.com/embed/D01HYV8yAiw?rel=0

Frequency Filtering

Demonstrates how to use the Frequency Filter in three different applications.



https://www.youtube.com/embed/HClFGOyt6jI?rel=0

Memory Steps

Shows examples of setting, calling, and using memory steps in a Recipe.


https://www.youtube.com/embed/X2GzqYL_i88?rel=0
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https://www.youtube.com/embed/ex7UHo7tvro?rel=0

Smart Cluster™

Demonstrates use of the Smart Cluster function for simple and objective multi-class segmentation.
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https://www.youtube.com/embed/FxebQbpdRuE?rel=0

Color Cluster™

Demonstrates use of the Color Cluster function for simple and objective color segmentation.
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Color Deconvolution

Demonstrates use of the Color Deconvolution function to highlight features of certain colors.
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Smart Find™

Demonstrates two example uses of Smart Find in Aufo Segmentation for powerful and objective feature
detection.



https://www.youtube.com/embed/KlkunloiWkE?rel=0
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https://www.youtube.com/embed/GSrwRvSFh4E?rel=0

Polishing

Calibrating The Scale

Shows how to calibrate the scale (i.e. calculate the pixel size) of your image, so that measurements can be
made in physical units of microns, instead of pixels.
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Setting Layers

Discusses the power and procedures behind setting recipe steps as Layers.
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Setting Chapters

Discusses the advantages and procedures behind recipe Chapters.

Page 52 of 670


https://www.youtube.com/embed/zbU_-hh6m4M?rel=0

Adding Notes & Flags

Demonstrates how to add Notes and Flags to Recipe steps.



https://www.youtube.com/embed/_h3zoYKzdTM?rel=0
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https://www.youtube.com/embed/xg55EgZbrUg?rel=0

Measuring

Generating Measurements

Demonstrates how to generate Global and Feature Measurements from segmented features of interest in an
image.
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Coloring By Measurements

Demonstrates how to color segmented features according to any of their available measurements.



https://www.youtube.com/embed/m_Nd_ETglH4?rel=0
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https://www.youtube.com/embed/kvhZrzKOubE ?rel=0

Local Measurements

Demonstrates how to extract and visualize Local Measurements such as area fraction and thickness.
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https://www.youtube.com/embed/WhAKIuBIiXs?rel=0

Measuring Feature Intensities

Demonstrates how to measure aspects of grayscale intensities within selected features.
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https://www.youtube.com/embed/DjX1gcxsKOM?rel=0

Batch Processor

Running a Batch

Shows how to setup and run a batch process to segment and measure features from a set images.



https://www.youtube.com/embed/KXbY8vPeroM?rel=0
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Session Processor (formerly Post Processor)

Reviewing a 2D Batch

Shows how to review and edit multiple images after they have been batch processed to segment features of
interest.

https://www.youtube.com/embed/whP14230Y 1k?rel=0

Generating Measurements

Shows how to generate measurements from multiple images after they have been batch processed to
segment features of interest.
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https://www.youtube.com/embed/KyzyMeVz0bM?rel=0

Al Session Processor (formerly Deep
Learning Trainer)

Demo Video illustrating the use of the Al Session Processor

Tracing

Shows examples of tracing features of interest to develop training data.

Training

Shows example of training a deep learning model.

Applying

Shows example of applying a deep learning model to a new image.


https://www.youtube.com/embed/ACvg6LAsqRY?rel=0

3D Toolbox

Overview of 3D Reconstruction

Shows the workflow for creating, processing, visualizing, and measure a 3D Reconstruction.

Downloads

You may download the below assets to use as learning tools and follow this tutorial.

¥ Raw Dataset

¥ Calibration Data

¥ Segmentation Recipe



https://www.youtube.com/embed/sTMwAB9xPgQ?rel=0
https://mipar-content.s3.amazonaws.com/01+-+Raw+Data.zip
https://cdn.manula.com/user/7310/docs/3d-demo-calibration.zip
https://cdn.manula.com/user/7310/docs/3d-demo-recipe.rcp
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Recipe Store

Enter Recipe Store »

What Is It?

The Recipe Store is a fantastic resource for getting the most out of MIPAR. Find and download Recipes for
all sorts of segmentation problems. You'll learn fast and accelerate your work.

How Does It Work?

Browse the Recipes. Download the ones you like. We'll post examples next to them when possible. Every
Recipe has common info so you know what you’re getting.

Custom Recipes

One of MIPAR’s unique features is the ability for you to receive custom Recipes from our experts anytime.
Just submit an image here, and we’ll return a Recipe for your task as quickly as possible. If needed, a
member of our team will reach out for additional information.
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Image Processor

The Image Processor is the most commonly used app. It is used for building and editing Recipes, as well as
applying Recipes to single images. Recipes are sequences of image processing steps, in the right order and
with the right settings, which work to identify features of interest from your image.

Topics

+ Layout

» The Recipe

* Recipe Templates
» Chapters

+ Layers
* Notes, Flags, Interruptible, Custom Recipe Names

» Simple Recipe Mode
» Calibrating The Scale
+ Scale Bar

* Optimization

* Measurements

» Functions
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L_ayout

Below is labeled screenshot of the Image Processor which reveals the layout of and purpose behind each
user interface element.

@) Image Processor - ] X
| T Edit  Color PreProcessing Segmentation  Morphology  Clean-Up _ Memory  Math [ View Meosurements Toa\sl[Menu Bar]
—
Shortcut Bar B Save Image O Save Recipe

Help or Notes on Selected Recipe Step.

Help Mode:  Brief description of ihe selecied Recipe siep
Nates Mode: Type notes and comments on the selected Recipe step

Interactive Tools

— Set Step as Layer
Reference Image Reference Viewing Mode a4

DETECTION

Process Controls

Reference Image i Current Image Measurements Controls

o¥s See Keyboard Shortcuts for shortcuts relevant to the Image Processor.
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The Recipe

MIPAR’s unique technology is the Recipe. Like an engine of a car, you use the one that’s right for the job.
Make them yourself, start with one from the 80+ built-in templates, or get one custom-designed for you.

Recipes are built in the Image Processor, and are a sequence of image processing steps, in the right order
and with the right settings, which work to identify features of interest from your image. Each step you take
gets automatically recorded. Recipes are completely non-destructive, meaning that previous steps can be
edited or removed, new steps inserted, and changes will propagate down the rest of the sequence. Any step
of a Recipe can be double-clicked to show its result.

In addition to processing steps, Recipes can also contain global measurements. If there are no Layers in a
Recipe when it is run on an image or a bat